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Record Definition Files 
The grouper relies on a text file called a Record Definition File (RDF) to indicate the field 
position (column number) of each of the mandatory fields in the input file. The entries in the 
RDF act as pointers so that the grouper knows the location of each field in the input file. Each 
time the grouper is run, the user must ensure that an appropriate RDF is selected. 

For convenience, the grouper installation includes sample RDFs; one for each of the data types 
that the application can process. These files can be found in the grouper installation folder. The 
grouper provides methods for creating user-defined RDFs (see below) but the user may find 
that the sample RDFs provided with the application are sufficient. 

It is not necessary for the RDF to specify the positions of all the fields in the input file; only the 
mandatory fields must be specified. For a list of mandatory fields for each data type see the 
Guide to File Preparation document. 

Where the input file contains fields that are not specified in the RDF, the grouper simply ignores 
these fields during processing and passes them to the output file. The only reason to specify 
non-mandatory input fields in the RDF is where the grouper’s internal file viewer is used to view 
output files. The internal file viewer displays only those fields that are specified in the RDF. 

 

Grouping Modes 

The grouper offers three modes of operation: 

•  Non-interactive file grouping using the command-line mode. 

•  Interactive file grouping using the graphical user interface. 

•  Interactive record grouping using the graphical user interface (single spell grouping) 

 

Running the Grouper from the Command Line (non-interactive mode) 
The Grouper can process a file using the command line and parameters below (mandatory 
parameters are enclosed within <angle brackets>, optional parameters are enclosed within 
[square brackets]): 

HRGGrouper -i<Input File> -o<Output File> -d<Record Definition File> -l<Grouping 
Logic> [-h] [-r<report filename>] 
 

An example command line to run the grouper is shown below: 
HRGGrouper -i "C:\Grouper Testing\HRG4\1000 episodes\1000 
episodes.CSV" -o "C:\Grouper Testing\HRG4\1000 episodes\1000 
episodes-out.csv" -d "C:\Program Files\IC\HRG4 2008_09 RC 
Grouper\HRG4_sample_APC.rdf" -l apc_v42rc –h -r APCFCEReport003.rgf 
-r APCFCEReport005.rgf 

 



 
 

The Casemix Service 

HRG 2008/09 Reference Costs Grouper User Manual Page 4 of 39 
Author: Casemix Service  
 

Copyright © 2009, The Information Centre, Casemix Service. All rights reserved. 

The available Grouping Logic parameters are: 
 apc_v42rc Admitted Patient Care 
 nap_v42rc Non-Admitted Consultations 
 em_v42rc Emergency and Urgent Care 
 acc_v42rc Adult Critical Care 
 pcc_v42rc Paediatric Critical Care 
 ncc_v42rc Neonatal Critical Care 
  

Any messages generated by the application while running in command-line mode, such as the 
number of records processed, are written to the HRG.LOG file. 

Before running the command, the working directory must be set to the directory of the Grouper 
executable (HRGGrouper.exe). Use path names for the input file, the output file and the record 
definition file where they are located in other directories. 

A sample batch file is shown below: 

C: 

cd "C:\Program Files\IC\HRG4 2008_09 RC Grouper" 

HRGGrouper -i "C:\Grouper Testing\HRG4\1000 episodes\1000 
episodes.CSV" -o "C:\Grouper Testing\HRG4\1000 episodes\1000 
episodes-out.csv" -d "C:\Program Files\IC\HRG4 2008_09 RC 
Grouper\HRG4_sample_APC.rdf" -l apc_v42rc –h -r APCFCEReport003.rgf 
-r APCFCEReport005.rgf 

Grouping in Interactive Mode 
Interactive mode uses the grouper’s graphical user interface. Start the grouper using the 
shortcut on the Windows Start menu. 

Steps to group a file 
• Export data (e.g. from a Patient Administration System or other computer system) in 
comma-separated text format. It is strongly recommended that field names are included as 
the first row of the data extract; this makes it considerably easier to work with the file. 
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• On the main screen Current Database tab, select the Database that corresponds to the data 
type to be grouped. 

 
 

 

Click here 
to select 

database 

 

• On the main screen toolbar, click on the [Open RDF File] button  and select an 
appropriate Record Definition File (RDF) for the database to be used for grouping. Ensure 
that the RDF is intended for the same data type as the selected database (e.g. if the selected 
database is Admitted Patient Care, ensure that the RDF was designed to describe Admitted 
Patient Care data). Failure to ensure that the data type of the RDF and the database match 
will lead to grouping errors. 
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• In the RDF Editor, the field positions for the RDF may need to be altered to match the input 
file; check them and make any required changes. 

 
 

• To save the revised RDF click the [Save RDF File] button  and then close this tab by 
clicking the ‘x’ in the upper right corner of the RDF tab. 
 
• On the Current Database tab (see screenshot above), select the RDF by clicking the 
[Browse…] button and navigating to the required RDF. 
 
• From the [Tools] menu select [Process File…], this opens Process File dialog box. Select 
the input file (the data to be grouped) using the browse button (folder icon) next to the input 
file field. Check the [Input data has headings] check box if the input data includes field 
names in the first row. 
  
• Select the name and location for the creation of the output file using the browse button 
(folder icon) next to the output file field. The output file is the file that will contain the grouped 
data. 
 
• When all selections have been made, click the [Process] button to produce the grouped 
output file. A progress bar is displayed. When grouping Admitted Patient Care data, grouping 
is preceded by a data sorting phase; a separate progress bar is shown for sorting. 
 
• When grouping is complete, the Process File dialog box will close and the application 
returns to the Main Screen. 
 
• It is very important that the user examines the entries in the log area after grouping.  If 
grouping fails, this will be reported in the log area. 
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• Note that the output file is a text file and may therefore be opened using a variety 
applications. 
• To open the output file from within the application, select [Display File…] from the [Tools] 
menu.  Navigate to the location of the output file.  The display will be similar to the screenshot 
below: 
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The Grouper Main Screen 
The Main Screen has a main menu, a toolbar, a tabbed display and a log area. 
 
• Main Menu 

 
File 

New RDF  Opens the RDF Wizard. 
Open RDF Opens a selected RDF for editing or review within the tabbed display area. 
Save Saves a currently open RDF (only available when an RDF is being edited). 
Save As Saves a currently open RDF with the option to rename or change location 

(only available when an RDF is being edited). 
Exit Closes the application. 

 
Edit 

Insert Field Inserts a new line in an RDF for user-defined fields (only available when 
an RDF is being edited). 

Delete Field Deletes the currently selected user-defined field in an RDF (only available 
when an RDF is being edited). 

 
Tools 

Process File Opens the Process File dialog box. 
Display File Opens a selected file within the tabbed display area. 
Single Spell Opens the Single Spell Grouping screen. 
Run Reports Opens the Run Reports dialog box 
Select Database Opens the Database Selection dialog box. 

 
Help 

Index  Opens the user manual. 
Latest User Manual Opens a web page where the latest user manual can be opened or 

downloaded. 
About  Opens the About screen to display application version and contact 

information. 
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• Toolbar 

 
 

 New RDF  Opens the RDF Wizard. 

 Open RDF  Opens a selected RDF for editing or review within the tabbed 
display area. 

 Save  Saves a currently open RDF (only available when an RDF is 
being edited). 

 Insert Field  Inserts a new line in an RDF for user-defined fields (only 
available when an RDF is being edited). 

 Delete Field  Deletes the currently selected user-defined field in an RDF (only 
available when an RDF is being edited). 

 Process File  Opens the Process File window 

 Run Reports  Opens the Run Reports box 

 Display File  Opens a selected file within the tabbed display area 

 Single Spell Grouping Opens the Single Spell Grouping screen 
 
• Tabbed Display Area 
This area shows screens that can be viewed by selecting the tabs at the bottom of the 
window when more than one of the following are open: 

•  Database Selection  
•  Record Definition File Editor  
•  File Display  

 
• Log Area 
This area displays progress and status messages during and after grouping. 
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Current Database 

 
 

The current database is shown on the main window of the application (see screenshot above). 

The user must ensure that the Database selected matches the data type of the Record 
Definition File and the type of data to be grouped. Failure to ensure that the data type of the 
RDF and the database match will lead to grouping errors. 

The Record Definition File drop-down box displays any Record Definition Files that have been 
used within the current session.  The [Browse] button allows the user to locate Record Definition 
Files. 
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Record Definition File Wizard Step One 
Note that sample Record Definition Files are provided as part of the grouper installation 
program; these can be found within the grouper program folder. User-defined RDFs allow 
users the flexibility of using the grouper with locally-defined input file layouts. 
 

 
 

A Record Definition File (RDF) is required by the Grouper to identify the locations of the fields in 
the source data.  The Record Definition File Wizard allows the user to create a Record 
Definition File. 

The mandatory fields required in the RDF are different for each database. 

The [Create fields manually] option allows the user to use a grid to define field positions and 
attributes.  To jump straight to the RDF editor, select this option and click the [Next] button. 

The [Create from a sample file] option allows the user to create an RDF interactively using a 
sample data file.  Clicking [Next] will prompt the user to select the file on which the RDF is to be 
based. 
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Record Definition File Wizard Step Two 
Where the user selects [Create from a sample data file] from the dialog box described in 
Step One, the user is prompted to browse for the file, after which the dialog box shown below 
is displayed: 
 

 

Preview 
area 

 
The first row of the data file is displayed in the lower part of the dialog box (the preview area), 
above it temporary field names (‘Field 1’ etc.) are shown. 

The preview area automatically assigns field positions based on the comma positions in the file. 

For Admitted Patient Care, the ‘Number of diagnosis codes’ and ‘Number of procedure codes’ 
values may be edited to allow the processing of files that contain a non-standard number of 
clinical codes. Other data types allow similar increases in the numbers of specific fields; see 
Guide to File Preparation for details. 

All entries in the Mandatory Fields list must be assigned to fields in the sample file.  Fields are 
assigned by dragging the name from the list to the appropriate field in the preview area.  Fields 
appear in the Assigned Fields list as they are used.  The screenshot below shows the process 
partially completed (first three fields assigned). 
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Multiple fields can be selected using the SHIFT and CTRL keys in combination with mouse 
clicks.  The selected collection of fields can then be dragged to the preview area. 

To remove an assigned field, select it in the Assigned Fields list and press the Delete key.  The 
field will be returned to the bottom of the Mandatory Fields list (not its original position). 

When all fields have been assigned, click [OK] to proceed. The RDF will be opened in the RDF 
editor, allowing checking and any required amendments. 
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Record Definition File Editor 

 
 
The RDF Editor provides a manual method of assigning field positions and attributes. 
 
Field Name Field abbreviation. This is for internal use and cannot be changed. 
Field Title Field description - can be edited by the user to show a meaningful name for 

the field. 
Field No The field position in a comma-separated input file, with the first field being 

number one. 
Picture Allows the user to provide filtering instructions to the Grouper by describing 

a ‘Picture’ of the field.  During the processing the Grouper will apply this 
picture to the field and only use the specified characters.  Click here for 
examples. 

Extract Allows the user to provide filtering instructions to the Grouper by describing 
an ‘Extract’ instruction.  During processing the Grouper will apply this Extract 
instruction to the field and only the characters that the user has specified.  
Click here for examples. 

 
The [Insert] toolbar button inserts a new field in the RDF. This feature is provided so that 
non-mandatory fields can be shown using the ‘Display File’ feature. 
 
The [Delete] toolbar button removes a field from the RDF.  Mandatory fields cannot be 
deleted. 
 
When the RDF is saved the user will be informed if any validation checks (such as conflicting 
field positions) have been failed.  These issues must be resolved before the file can be saved. 
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Process File 
From the [Tools] menu select [Process File…], this opens Process File dialog box. Select 
the input file (data file) using the browse button (folder icon) next to the input file field.  
Note that with the default setting of 'Input files' selected in the 'Files of type' list, the 'Open' 
dialog box accessed via the browse button will list files with '.csv' and '.txt' extensions only. 
Change this value to ‘All Files’ if the input file has a different extension. 
Check the [Input data has headings] check box if the input data includes field names in the 
first row. 
Select the name and location of the output file using the browse button (folder icon) next to 
the output file field. The output file is the file that will contain the grouped data. 

 

 

Browse 
buttons 

 
When all selections have been made, click the [Process] button to group the file.  A progress 
bar is displayed. 
When grouping is complete, the progress bar and the Process File dialog box will close; the 
application returns to the Main Screen. 
It is very important that the user examines the entries in the log area after grouping.  If 
grouping fails, this will be reported in the log area. 
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Display File 
The application provides a ‘Display File’ facility, accessed from the ‘Tools’ menu. The fields 
displayed using this facility are restricted to those defined in the Record Definition File. The field 
positions, pictures and extract values from the RDF are applied. The output is a text file so can 
be opened using other applications. 

 

 
 

The space beneath each field name allow the user to enter filter criteria to limit the records 
displayed based on one or more starting characters.  Pressing the Enter key activates the filter.  

In the example below ‘Y2’ has been entered under OPER_5 to limit the list to those records 
where the OPCS code starts with ‘Y2’:  

 
 
Double-clicking on a record within the display opens it in the Single Spell Grouping screen. 
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Single Spell Grouping 
This option allows the interactive grouping of input data.  The mandatory fields for the currently 
selected database are displayed within the upper area.  The user can insert data by typing into 
the Value column.  Pressing the Enter key displays the code’s description where a valid code 
has been entered.  A valid record definition file must be selected in order to use single spell 
grouping. 

The single spell grouping dialog box is shown below: 

 
 
Unlike the file grouping facility, the single spell grouping function does not attempt to validate 
input fields and will allocate an HRG provided there is sufficient information to do so, i.e. at 
least a valid primary diagnosis. 
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Clicking the [Click To Add Episode] header bar will open an adjacent set of columns 
allowing values for a second episode to be entered and grouped as part of the same spell. 
 
Clicking the [Group] button will process the values entered and will display the HRG and 
other derived information in the output (lower) area. 
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Database Selection Screen 
 
From the [Tools] menu, select [Select Database…] to open the dialog box shown below: 
 

 
 
This dialog box provides both an alternative mechanism for selecting the current database 
and a way of exporting database tables. 
 
The Table drop-down box displays a list of data files that make up the currently chosen 
database.  Selecting one will show a brief description of it in the accompanying area. 
 
Clicking [Select] will set the Grouper to use the selected database. 
 
Clicking the ‘Export’ button will export the selected table, the user being prompted for a 
filename and location. 
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Reports 
The reports are created specifically to support the NHS Reference Costs process; they are 
not intended for any other purpose. 
The reports are produced as xml spreadsheets; these can be opened using Microsoft Excel 
version 2002 or later. 
With versions of Excel prior to Excel 2007, worksheet size was limited to 65,536 rows. When 
reports are generated from very large data sets, the number of report rows may exceed this 
number. When opening a report where the number of rows exceeds the available number of 
worksheet rows, Excel will display an error message such as ‘Problems During Load’. In this 
case the entire report may be viewed using Excel 2007 or later. 
 
Admitted Patient Care 
 
Automatic Adjustments in Admitted Patient Care reports 
 
During report generation, one day is automatically added to the episode duration of 
zero-length ordinary admission episodes (Patient Classification = 1). This is in line with NHS 
Reference Costs guidance. This does not apply to daycases. 
 
FCE Reports 
 

Report Title Command line Output file name extension 
FCE Daycases by TFC and 
HRG4 

APCFCEReport001.rgf _APCFCEReport001.xml 

FCE Daycases 
Diagnosis/Procedure by TFC 
and HRG4 

APCFCEReport002.rgf _APCFCEReport002.xml 

FCE Truncated Elective 
Inpatient Bed Days by TFC 
and HRG4 

APCFCEReport003.rgf _APCFCEReport003.xml 

FCE Truncated Elective 
Inpatient Bed Days 
Diagnosis/Procedure by TFC 
and HRG4 

APCFCEReport004.rgf _APCFCEReport004.xml 

FCE Truncated Non-Elective 
Inpatient Bed Days by TFC 
and HRG4 

APCFCEReport005.rgf _APCFCEReport005.xml 

FCE Truncated Non-Elective 
Inpatient Bed Days 
Procedure/Diagnosis by TFC 
and HRG4 

APCFCEReport006.rgf _APCFCEReport006.xml 
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Report Title Command line Output file name extension 
FCE Excess Inpatient Bed 
Days by TFC and HRG4 

APCFCEReport007.rgf _APCFCEReport007.xml 

Unbundled HRG4 - Admitted 
Patient Care 

APCFCEReport008.rgf _APCFCEReport008.xml 

Truncated Non-elective long-
stay 

APCFCEReport009.rgf _APCFCEReport009.xml 

Truncated Non-elective long-
stay emergency 

APCFCEReport010.rgf _APCFCEReport010.xml 

Truncated Non-elective long-
stay non-emergency 

APCFCEReport011.rgf _APCFCEReport011.xml 

Non-elective short-stay APCFCEReport012.rgf _APCFCEReport012.xml 
Non-elective short-stay 
emergency 

APCFCEReport013rgf _APCFCEReport013.xml 

Non-elective short-stay non-
emergency 

APCFCEReport014.rgf _APCFCEReport014.xml 

 
Spell Reports 
 

Report Title Command line Output file name extension 
Spell Daycases by HRG4 APCSpellReport001.rgf _APCSpellReport001.xml 
Spell Daycases 
Diagnosis/Procedure by 
HRG4 

APCSpellReport002.rgf _APCSpellReport002.xml 

Spell Truncated Elective 
Inpatient Bed Days by HRG4 

APCSpellReport003.rgf _APCSpellReport003.xml 

Spell Truncated Elective 
Inpatient Bed Days 
Diagnosis/Procedure by 
HRG4 

APCSpellReport004.rgf _APCSpellReport004.xml 

Spell Truncated Non-Elective 
Inpatient Bed Days by HRG4 

APCSpellReport005.rgf _APCSpellReport005.xml 

Spell Truncated Non-Elective 
Inpatient Bed Days 
Diagnosis/Procedure by 
HRG4 

APCSpellReport006.rgf _APCSpellReport006.xml 

Spell Excess Inpatient Bed 
Days by HRG4 

APCSpellReport007.rgf _APCSpellReport007.xml 

Note: there is no report 008 for Spells 
Non-elective long-stay APCSpellReport009.rgf _APCSpellReport009.xml 
Non-elective long-stay APCSpellReport010.rgf _APCSpellReport010.xml 
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emergency 
Non-elective long-stay non-
emergency 

APCSpellReport011.rgf _APCSpellReport011.xml 

Non-elective short-stay APCSpellReport012.rgf _APCSpellReport012.xml 
Non-elective short-stay 
emergency 

APCSpellReport013.rgf _APCSpellReport013.xml 

Non-elective short-stay non-
emergency 

APCSpellReport014.rgf _APCSpellReport014.xml 

 
Non-Admitted Consultations 
 

Report Title Command line Output file name extension 
Non-Admitted Consultations 
(Excluding Chapter WF) by 
TFC and HRG4 

NACReport001.rgf _NACReport001.xml 

Non-Admitted Consultations 
(Chapter WF Only) by TFC 
and HRG4 

NACReport002.rgf _NACReport002.xml 

Unbundled HRG4 - Non-
Admitted Consultations 

NACReport003.rgf _NACReport003.xml 

 
Adult Critical Care 
 

Report Title Command line Output file name extension 
Adult Critical Care by HRG4 ACCReport001.rgf _ACCReport001.xml 

 
Emergency and Urgent Care 
 

Report Title Command line Output file name extension 
Emergency and Urgent Care 
by HRG4 (A&E) 

EUCReport001.rgf _EUCReport001.xml 

 
The user has the option of producing reports either during processing a file or as a separate 
operation. 

To produce reports during file processing, select the required reports in the Process File dialog 
box. This is done using the check boxes next to the report names. 

To produce reports based on a data file that has already been grouped, select [Run Reports] 
from the [Tools] menu. This opens the Run Reports dialog box (shown below) which allows 
selection of the grouped data file and the record definition file that was used to group it. Select 
the required reports from the list by clicking the checkboxes and click the [Process] button 
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It is crucial that the file selected in the ‘Filename’ box is a previously processed non-relational 
FCE output file (the output file that has the name ending in ‘_FCE’). The use of other output files 
will result in reports that are either blank or contain incorrect figures. 

Note that reporting from a previously grouped file should only be done if the grouped file was 
produced using the same version of the HRG4 Reference Cost Grouper as that which is being 
used for reporting.  
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 Subtraction of Days from Admitted Patient Care Duration 

The Grouper facilitates the subtraction of days for Critical Care, Rehabilitation and Specialist 
Palliative Care from finished Consultant Episode and Hospital Provider Spell durations. 

Where the user populates the input data fields with numbers representing the appropriate days 
of activity, these will be used by the grouper to calculate modified output fields. 

In addition, the Rehabilitation and Specialist Palliative Care days are used as the multiplier for 
Rehabilitation and Specialist Palliative Care per diem HRGs.  

Although the fields are mandatory in the input data (i.e. the columns must exist in the file) they 
may be left blank or populated with zeros where appropriate.  

For further guidance on using this facility, please see the document ‘Guide to File Preparation’ 
which is available from the Casemix website. 
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Picture Field Examples 
Example 1 

Entering a Picture of 'AAA.AA' instructs the Grouper that the first three and last two characters 
of the field should be used. The fourth character is ignored. 

Example 2 

Entering a Picture of '.A.AAA' instructs the Grouper that the second character and last three 
characters should be used and the first and third characters should be ignored. 

Example 3 

Entering a Picture of '.A.' indicates that the Grouper should use the second character only and 
ignore the first and last characters. 

Note that when entering the Picture fields the characters which are entered should not be 
separated by spaces, and the number of characters making up the Picture should equal the 
value entered in the Length field.  So in the examples above the user will have entered the 
values '6', '6' and '3' respectively in the Length field. 
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Extract Field Example 
Example 
Entering an Extract instruction of "." informs the Grouper that all occurrences of "." should be 
ignored when processing that field.  This is a convenient way to remove decimal points from 
fields in the input batch file. 
 
Note that when entering the Extract instruction, the Grouper can be informed that more than 
one character should be stripped from the field. For example by entering a value of ".$" in this 
field informs the Grouper that both the "." character and "$" character should be ignored by 
the Grouper when processing that field. 
 
Note that it is not possible to extract the comma character using this facility. 
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Glossary 
 

cc  Complications and comorbidities 
CSV Comma Separated Value 
Diag Diagnosis 
HRGUSER.INI The HRG program initialisation file 
FCE  Finished Consultant Episode 
HRG  Healthcare Resource Group 
ICD-10 10th revision of the International Classification of 

Diseases 
OPCS-4 4th revision of Office of Population Censuses and 

Surveys Classification of Procedures 
PAS Patient Administration System 
PBC Programme Budgeting Categories 
PDiag Primary diagnosis 
PProc Primary procedure 
Proc Procedure 
RDF Record Definition File 
SSC Specialised Services Code 
Record Definition File The file defining the format of the data to be 

processed by the Grouper 
w with 
w/o without 
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Contact Information 
This software and associated materials are the Copyright © of the NHS Information Centre for 
Health and Social Care. 
 
Help is available for both technical and general queries from the NHS Information Centre for 
Health and Social Care contact centre: 

Telephone: 0845 300 6016 (Monday – Friday, 9am - 5pm) 
Email: enquiries@ic.nhs.uk 
http://www.ic.nhs.uk/casemix 

 

http://www.ic.nhs.uk/casemix
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Appendix 

Output Files 

The output files aim to meet the needs of those familiar with relational data as well as those who 
require non-relational files. Specific relational outputs include "_rel" as a part of the output 
filename. 

Generally, a single input file produces a number of output files. User requirements determine 
which files are used; some users may not require certain output files. In most cases an output 
field appears in more than one file. In the text below, the filename supplied by the user during 
processing is referred to as [filename]. 

Use of ‘RowNo’ and ‘Iteration’ Fields 

The role of the ‘RowNo’ field is to provide a method of uniquely identifying FCEs within output 
files. The existence of a unique identifier for FCEs allows related records to be identified in 
different output files. 

For example, in the case of unbundled HRGs, the file [filename]_ub_rel.csv shows the 
unbundled HRGs for each output row. The field ‘RowNo’ contains the ‘RowNo’ of the matching 
output record in the file [filename]_FCE.csv. If these files are imported to a relational database, 
the ‘RowNo’ fields can be used as the basis from which to derive keys to allow the relationship 
between these records to be represented. 

Where there is more than one related record, for example where there are more than one 
unbundled HRGs for an FCE, the field ‘Iteration’ is used to differentiate between the multiple 
related records.  

Examples of where ‘Iteration’ is used are: 

•  an input row may generate more than one unbundled HRG 

•  an input row may result in more than one data quality message 

There is no significance to the numerical values of ‘Iteration’, the numbers are assigned in order 
according to the order of the input data (the sorted input data in the case of files that are sorted 
prior to grouping). 

Admitted Patient Care 

A single input file produces eleven output files. 
  
1. File  [filename].csv.  A list of other output files; this file is for validation only and will 

normally be ignored by users. 
 
2. File  [filename]_sort.csv.  This a copy of the input data after it has been sorted into 

Provider Code, Spell Number, Episode Number order prior to grouping.  It also contains 
a unique row number added as a final column assigned after the sorting process.  This 
row number is intended to be used as the key when using relational data.  
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3. File  [filename]_FCE.csv.  This file contains both FCE and spell output fields. The spell 
fields are repeated for each episode in the spell; beware of double-counting when using 
spell fields. The file structure is as follows: 
<input data> All of the input data for the FCE, including any non-mandatory 

fields are reproduced in the output. 
RowNo. The row number field mentioned in the "sort" file.  It is unique 

within the file. 
FCE_HRG. The episode level Core HRG. 
GroupingMethodFlag. An indication of the grouping method used for the episode.  

"P" = procedure driven, "D"=diagnosis driven. 
DominantProcedure. The dominant procedure used for procedure based grouping. 
FCE_PBC. This field is populated in reference costs groupers only.  It 

contains the Programme Budgeting Category. 
CalcEpidur. The calculated episode duration.  This is the input Episode 

duration minus the number of critical care days entered. 
ReportingEpidur. The episode duration used when generating reports. 
FCETrimpoint. The episode trimpoint for the HRG allocated to the episode. 
FCEExcessBeddays. The number of days that the episode exceeds the trimpoint. 
SpellReportFlag. Used when generating reports from grouped data. 
SpellHRG. The spell level Core HRG.  
SpellDominantProcedure. DominantProcedure at spell level. 
SpellPDiag The primary diagnosis used when spell grouping. 
SpellSDiag The 1st secondary diagnosis used when spell grouping. 
SpellEpisodeCount The number of episodes in the spell 
SpellLoS The duration of the spell used for grouping 
ReportingSpellLoS The length of stay used when generating reports. 
SpellTrimpoint. The trimpoint for the HRG allocated to the spell. 
SpellExcessBeddays. The number of days the spell exceeds the trimpoint. 
SpellCCDays The number of critical care days in the spell. 
UnbundledHRGs A variable number of fields containing unbundled HRGs (at 

episode level).  
Unbundled HRGs are appended to the end of each record; 
there may be zero, one or more unbundled HRGs per record.  
For Specialist Palliative Care and Rehabilitation unbundled 
HRGs, where there is more than one daily HRG, the field 
consists of an HRG, followed by an asterisk, followed by the 
number of days, rather than the HRG repeated for every day. 
E.g. VC18Z*20 indicates VC18Z for 20 days. 

 
4. File  [filename]_spell.csv.  This file could be considered semi-relational.  It contains one 

row per spell.  However, it also contains all of the SSCs generated for the spell in a flat 
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structure like unbundled HRGs in the FCE output. The FCE input data is not reproduced.  
The row number in the first column refers to the first row number in the sort or FCE output 
and will always be the first episode in the spell after sorting. 

 
RowNo. The key into other files. Unless all spells in the input data each 

consist of a single episode, RowNo in the spell file is not 
continuous (i.e. some numbers are absent). 

SpellHRG. The spell level Core HRG.  The first of the spell level output.   
Be careful to avoid double-counting when using spell level 
fields. 

SpellDominantProcedure. DominantProcedure, but at spell level. 
SpellPDiag The primary diagnosis used when spell grouping. 
SpellSDiag The 1st secondary diagnosis used when spell grouping. 
SpellEpisodeCount The number of episodes in the spell 
SpellLoS The duration of the spell used for grouping 
ReportingSpellLoS The length of stay used when generating reports. 
SpellTrimpoint. The trimpoint for the HRG allocated to the spell. 
SpellExcessBeddays. The number of days the spell exceeds the trimpoint. 
SpellCCDays The number of critical care days in the spell. 
SpellSSC1 The first possible SSC produced for the spell.  The grouper 

does not check eligibility.  All SSCs possible are output, for 
organisational SSC eligibility, check DH guidance. 

SpellSSC2 The second possible SSC produced for the spell.   
…  
SpellSSC10 The tenth possible SSC produced for the spell.   
UnbundledHRGs An aggregate of all unbundled HRGs produced for episodes in 

the spell. 
 
5. File  [filename]_quality.csv.  This file contains one row per episode for all episodes in a 

spell that have an error, including episodes in that spell that do not have any errors (those 
records do not have an error message).  This means that the user can see all of the input 
data and all error messages for a spell that has failed validation.  Its structure is as 
follows. 

 
<input data> All of the input data for the FCE, including any non-mandatory 

fields are reproduced in the output. 
RowNo. The row number field mentioned in the "sort" file.  It is unique 

within the file. 
Error Message. A variable number of fields containing the error message.  

Each message is the three fields shown in the relational 
quality file separated by pipe "|" symbols.  
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6. File  [filename]_FCE_rel.csv.  This file contains the FCE level output in relational form.  
There are a fixed number of columns. 

 
RowNo. The row number field mentioned in the "sort" file.  It is unique 

within this file. 
FCE_HRG. The episode level Core HRG. 
GroupingMethodFlag. An indication of the grouping method used for the episode.  

"P" = procedure driven, "D"=diagnosis driven. 
DominantProcedure. The dominant procedure used for procedure based grouping. 
FCE_PBC. This field is populated in reference costs groupers only.  It 

contains the Programme Budgeting Category. 
CalcEpidur. The calculated episode duration.  This is the input Episode 

duration minus the number of critical care days entered. 
ReportingEpidur. The episode duration used when generating reports. 
FCETrimpoint. The episode trimpoint for the HRG allocated to the episode. 
FCEExcessBeddays. The number of days that the episode exceeds the trimpoint. 
SpellReportFlag. Used when generating reports from grouped data. 
 

 
 
7. File  [filename]_spell_rel.csv.  This file contains the Spell level output in relational form.  

There are a fixed number of columns.  One entry will be produced per spell. 
 

RowNo. The key into other files. 
SpellHRG. The spell level Core HRG.  The first of the spell level output.   

Be careful to avoid double-counting when using spell level 
fields. 

SpellDominantProcedure. DominantProcedure, but at spell level. 
SpellPDiag The primary diagnosis used when spell grouping. 
SpellSDiag The 1st secondary diagnosis used when spell grouping. 
SpellEpisodeCount The number of episodes in the spell 
SpellLoS The duration of the spell used for grouping 
ReportingSpellLoS The length of stay used when generating reports. 
SpellTrimpoint. The trimpoint for the HRG allocated to the spell. 
SpellExcessBeddays. The number of days the spell exceeds the trimpoint. 
SpellCCDays The number of critical care days in the spell. 
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8. File  [filename]_quality_rel.csv.  All of the error messages in relational form.  There will be 
no entries for FCEs or Spells that have no errors produced. 

 
RowNo. The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the problem. 
Error Message Explanation of the problem. 

 
9. File  [filename]_ssc_rel.csv.  The SSCs produced during the run.  There will be no entries 

for Spells that have no SSCs produced. 
 

RowNo. The key into other files.  In this case it will be the row number 
associated to the spell/first episode in the spell. 

Iteration In conjunction with RowNo, provides a unique key for the 
record. 

SSC The SSC derived for the parent spell 
 
10. File  [filename]_ub_rel.csv.  The unbundled HRGs produced during the run.  There will be 

no entries for episodes that do not have any unbundled HRGs. 
 

RowNo. The key into other files.  In this case it will be the row number 
associated to the episode in the spell. 

Iteration In conjunction with RowNo, provides a unique key for the 
record. 

UnbundledHRG The unbundled HRG 
 
11. File  [filename]_summary.csv.  A single-row file containing details about the grouping run: 
 

Grouper Version. The version of the grouper that produced the run. 
FCE Count The number of episodes submitted to the run. 
Spell Count The number of spells submitted to the run. 
FCE Error Count The number of episodes with errors. 
Spell Error Count The number of spells with errors. 
Run Start Date/Time The data/time that the run started. 
Run End Date/Time The data/time that the run finished. 
Input Filename The path and filename of the input file. 
Input Filename The path and filename of the first output file mentioned above. 
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RDF path and name The path and filename of the rdf file used in the run. 
 

Non Admitted Care 

A single input file produces seven output files. 
 
1. File  [filename].csv. Contains a list of all the other files produced.  This file will 

normally be ignored. 
 
2. File  [filename]_attend.csv. This is sometimes known as the attendance flat output.  Its 

structure is as follows: 
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo. A unique row number field applied when grouping.  This 
serves as the key for other output files. 

NAC_HRG. The Core HRG for the attendance. 
GroupingMethodFlag. An indication of the grouping method used for the attendance. 
DominantProcedure. The dominant procedure used for procedure based grouping. 
UnbundledHRGs A variable number of fields containing unbundled HRGs (at 

episode level).  
Unbundled HRGs are appended to the end of each record; 
there may be zero, one or more unbundled HRGs per record.  

 
3. File  [filename]_quality.csv.  This file contains one row per attendance that contain errors.  

Its structure is as follows: 
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo. The row number field mentioned in the attend file.  It is unique 
within the file. 

Error Message. A variable number of fields containing the error message.  
Each message is the three fields shown in the relational 
quality file separated by pipe "|" symbols.  

 
4. File  [filename]_attend_rel.csv.  This is sometimes known as the attendance relational 

output.  Its structure is as follows: 
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 
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RowNo. A unique row number field applied when grouping.  This 
serves as the key for other output files. 

NAC_HRG. The Core HRG for the attendance. 
GroupingMethodFlag. An indication of the grouping method used for the attendance. 
DominantProcedure. The dominant procedure used for procedure based grouping. 
 

5. File  [filename]_quality_rel.csv.  All of the error messages in relational form.  There are no 
entries for attendances that do not contain errors. 

 
RowNo. The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the problem. 
Error Message Explanation of the problem. 
 

6. File  [filename]_ub_rel.csv.  The unbundled HRGs produced during the run.  There are no 
entries for attendances that do not have unbundled HRGs. 

 
RowNo. The key into other files.   
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
UnbundledHRG The unbundled HRG 
 

7. File  [filename]_summary.csv.  A sinlge-row file containing details about the grouping run: 
 

Grouper Version. The version of the grouper that produced the run. 
Attendance Count The number of attendances submitted to the run. 
Attendance Error Count The number of attendances with errors. 
Run Start Date/Time The date/time that the run started. 
Run End Date/Time The date/time that the run finished. 
Input Filename The path and filename of the input file. 
Input Filename The path and filename of the first output file mentioned above. 
RDF path and name The path and filename of the rdf file used in the run. 

 
Emergency Medicine 

A single input file produces five output files. 
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1. File  [filename].csv.  Contains a list of all the other files produced.  This file will normally 
be ignored. 

 
2, File  [filename]_attend.csv.  This is sometimes known as the attendance flat output.  Its 

structure is as follows: 
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo. A unique row number field applied when grouping.  This 
serves as the key for other output files. 

EM_HRG. The Core HRG for the attendance. 
 
3. File  [filename]_quality.csv.  This file contains one row per attendance that have errors.  

Its structure is as follows: 
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo. The row number field mentioned in the attend file.  It is unique 
within the file. 

Error Message. A variable number of fields containing the error message.  
Each message is the three fields shown in the relational 
quality file separated by pipe "|" symbols.  

 
4. File  [filename]_quality_rel.csv.  All of the error messages in relational form.  There will be 

no entries for attendances that have no errors produced. 
 

RowNo. The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the problem. 
Error Message Explanation of the problem. 

 
5. File  [filename]_summary.csv.  A single-row file containing details about the grouping run. 
 

Grouper Version. The version of the grouper that produced the run. 
Attendance Count The number of attendances submitted to the run. 
Attendance Error Count The number of attendances with errors. 
Run Start Date/Time The date/time that the run started. 
Run End Date/Time The date/time that the run finished. 
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Input Filename The path and filename of the input file. 
Input Filename The path and filename of the first output file mentioned above. 
RDF path and name The path and filename of the rdf file used in the run. 

 
Adult Critical Care 

A single input file produces five output files. 
  
1. File  [filename].csv.  Contains a list of all the other files produced.  This file will normally 

be ignored. 
 
2. File  [filename]_acc.csv.  Its structure is as follows. 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo. A unique row number field applied when grouping.  This 
serves as the key for other output files. 

ACC_HRG. The unbundled HRG for the ACC period.  All ACC HRGs are 
unbundled. 

Calc_CC_Days. The number of CC days derived from the start and end dates 
entered.  This will be -1 if there are problems with the dates. 

CC_Warning_Flag. Set to F, for Fail, if Calc_CC_Days is -1 or any of the checks 
mentioned below have failed.  This is not a part of the "cruel" 
input validation.  A single data row can fail here but also have 
a valid (non U group) HRG. 

 
Validation Checks 

Calc_CC_Days = CC Discharge date - CC Start Date + 1 
Set warning flag if: 
Calc_CC_Days = -1; or 
CCL2 Days + CCL3 Days > Calc_CC_Days; or 
ARSD + BRSD > Calc_CC_Days; or 
ARSD + BRSD > CCL2 Days + CCL3 Days 

 
3. File  [filename]_quality.csv.  This file contains one row per ACC record that contains 

errors.  Its structure is as follows. 
<input data> All of the input data for the record, including any non-

mandatory fields are reproduced in the output. 
RowNo. The row number field mentioned in the acc file.  It is unique 

within the file. 
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Error Message. A variable number of fields containing the error message.  
Each message is the three fields shown in the relational 
quality file separated by pipe "|" symbols.  

 
4. File  [filename]_quality_rel.csv.  All of the error messages in relational form.  There will 

be no entries for records that have no errors produced. 
RowNo. The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the problem. 
Error Message Explanation of the problem. 

 
5. File  [filename]_summary.csv.  A one row file containing details about the grouping run: 

Grouper Version. The version of the grouper that produced the run. 
ACC Record Count The number of attendances submitted to the run. 
ACC Record Error Count The number of attendances with errors. 
Run Start Date/Time The date/time that the run started. 
Run End Date/Time The date/time that the run finished. 
Input Filename The path and filename of the input file. 
Input Filename The path and filename of the first output file mentioned above. 

RDF path and name The path and filename of the rdf file used in the run. 
 

Neonatal Critical Care 

There are six output files. 
1. File  [filename].csv  A single-row file containing details about the grouping run. 
2. File  [filename]_ncc.csv  The main grouped output file. 
3. File  [filename]_quality.csv  Contains one row for each record that has errors. 
4. File  [filename]_quality_rel.csv  All of the error messages in relational form. 
5. File  [filename]_sort.csv  A copy of the input data after it has been sorted. 
6. File  [filename]_summary.csv  A single-row file containing details about the grouping 

run. 
 
 

Paediatric Critical Care 

There are six output files. 
1. File  [filename].csv  A single-row file containing details about the grouping run. 
2. File  [filename]_pcc.csv  The main grouped output file. 
3. File  [filename]_quality.csv  Contains one row for each record that has errors. 
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4. File  [filename]_quality_rel.csv  All of the error messages in relational form. 
5. File  [filename]_sort.csv  A copy of the input data after it has been sorted. 
6. File  [filename]_summary.csv  A single-row file containing details about the grouping 

run. 
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